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Preface

Scope
This manual describes the operation of the TEAM V.34/Dual software application. The inform
contained in this manual has been carefully checked and is believed to be entirely reliable. 
However, as General DataComm improves the reliability, function, and design of their produ
is possible that information may not be current. Contact General DataComm if you require up
information for this or other General DataComm products.

General DataComm, Inc.
Network Access Division
Technical Publications Department
Park Road Extension
Middlebury, Connecticut, USA 06762-1299
Tel:   1 203 758 1811 Toll Free:   1 800 794 8246

Manual Organization
This manual is divided into the following chapters: 

Chapter 1, Introduction to TEAM V.34/Dual 

Chapter 2, Operation 

Chapter 3, Configuration 

Chapter 4, Maintenance/Diagnostics 

This manual should be read in its entirety and all procedures completely understood before
installing or operating the unit. The notes that appear throughout this manual must be read p
any installation or operating procedure. Examples of notes used in this manual are shown b

Note Indicates a note. It is something you should be particularly aware of; something not readily
apparent. A note is typically used as a suggestion.

Important Indicates an emphasized note. It is something you should be particularly aware of; 
something not readily apparent. Important is typically used to prevent equipment dama
058R716-V300-000 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 v
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Service Support and Training
VITAL Network Services, a General DataComm company, is committed to providing the serv
support and training needed to install, manage, and maintain your GDC equipment. VITAL 
Network Services provides hands-on training courses through VITAL Network Services Global 
Technology Training Services. Courses range from basic data communications, modems an
multiplexers, to complex network and ATM systems. Training courses are available at our ce
in the US, UK, France, Singapore and Mexico, as well as at a customer’s site.

For more information VITAL Network Services or for technical support assistance, contact VI
Network Services at:

VITAL Network Services World Headquarters
6 Rubber Avenue Telephones: Faxes:
Naugatuck, Connecticut 06770 USA 1 800 243 1030 1 203 723 5012

1 888 248 4825 1 203 729 7611
http//www.vitalnetsvc.com 1 203 729 2461

VITAL Network Services Regional Sales and Service Offices:

North American Region Office
6 Rubber Avenue
Naugatuck, Connecticut 06770 USA
Telephones: 1 800 243 1030

1 888 248 4825
1 203 729 2461
1 800 361 2552 (French Canadian)

Training: 1 203 729 2461
Faxes: 1 203 723 5012

1 203 729 7611

Central America, Latin America
VITAL Network Services
Periferico Sur 4225, Desp. 306
C.P. 14210, Mexico D.F., Mexico

Telephone: 52 5 645 2238
Training: 52 5 645 2238
Fax: 52 5 645 5976

Europe, Middle East, Africa
VITAL Network Services
Molly Millars Close
Molly Millars Lane
Wokingham, Berkshire RG41 2QF UK

Telephone: 44 1189 657200
Training: 44 1189 657240
Fax: 44 1189 657279

Asia Pacific
VITAL Network Services
501 Orchard Road 05-05
Wheelock Place, Singapore 238880

Telephone: 65 735 2123
Training: 65 735 2123
Fax: 65 735 6889
vi TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 058R716-V300-000
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Chapter 1:  Introduction to
TEAM V.34/Dual

System Overview
This manual covers the General DataComm TEAM V.34/Dual Unix Application for HP 
OpenView. You should be familiar with HP OpenView and with the operation of modems in o
to use this manual effectively. 

The TEAM V.34/Dual Unix Application, which runs on either a Sun workstation or an HP platfo
is actually a collection of integrated applications for the HP OpenView Network Managemen
Platform. The applications use the Simple Network Management Protocol (SNMP) to manage
Dual V.34 modems installed in a SpectraComm shelf. 

TEAM V.34/Dual applications enable you to 

• Configure Dual V.34 modems and perform remote configuration on GDC V.34 modems
are connected to them as remote modems. 

• Monitor  the operation of the modems through displays of Alarms, Call Statistics and Mo
State, and through a Front Panel display that shows LED indicators as they appear on th
panel of the physical unit. 

• Diagnose suspected problems using local and remote loops (with or without Self Test) 
end-to-end Self Test. The dialing function is incorporated in the diagnostic application 
facilitate connections for remote loops and end-to-end tests. 

Dual V.34 Modem
The General DataComm Dual V.34 modem is in fact a pair of modems built onto one pc car
installation in a SpectraComm Shelf. The two are designated Modem A and Modem B, and 
function completely independent of each other. Each modem complies with the ITU-T V.34 
standard, and can support connection rates to a remote modem ranging from 300 bps to 28
Operation at 300 bps is asynchronous; from 1200 bps to 33.6 kbps operation can be either 
asynchronous or synchronous. Through the use of compression, it can support DTE data rat
128 kbps. 

The TEAM V.34/Dual manager application communicates with the Dual V.34 modem by mea
a SpectraComm Manager (SCM) card installed in the shelf with the modem. 
058R716-V300 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 1-1
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TEAM V.34/Dual Applications
TEAM V.34/Dual application menus are available in three ways: 

• From the menu bar of the Shelf Map window when a Dual V.34 modem is selected in th
window, select Front Panel 

• Double-click on the shelf icon.

• From the Select button on the Dual V.34 Front Panel display, click to open an application 

The Front Panel application displays current status information on the Dual V.34 modem by
displaying the state of the LED indicators on the front panel of the unit. A Select button menu a
you to invoke all other functions of the TEAM V.34/Dual manager. The applications that mak
the TEAM V.34/Dual manager are grouped on menus under the headings Performance, 
Configuration, Fault, and Misc (Miscellaneous):

Performance Menu provides

• Alarms – furnishes detailed information about alarm state changes.

• Modem State – displays information on the current status of modem operations. 

• Call Statistics – displays statistics concerning the current or (if there is not an active conne
most recently completed call.

• Reports – displays accumulated call statistics.

Configuration Menu provides

• Configure – configures Dual V.34 modems and to perform remote configuration on V.34
modems connected to them. 

• Maintenance – sets device-specific attributes that are not set as configuration options.

Fault Menu allows you to:

• run diagnostic tests on Dual V.34 modems

• perform dial functions for the modem.

Misc Menu provides:

• Information – displays revision level of the operating firmware of the Dual V.34 modem. 

Misc Menu in the Map window menu bar:

• Front Panel Poll Rate – enables you to set a default polling interval to be in effect each tim
Front Panel display is opened. 

• Note Pad – opens a shell tool on the workstation running the TEAM software. You can u
shell tool to run a text editor, mail tool, or any other software that resides on the worksta
The Note Pad application provides this access for keeping records on the system. 

Application Access options 

From the map window, Performance, Configuration, and Fault menus contain A and B selec
for each function. In the Select button menus on the Front Panel display, the selection betw
Modem A and Modem B is at the top of the menu structure followed by separate Performan
Configuration, and Fault menus for each modem. 
1-2 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 058R716-V300
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Theory of Operation
The TEAM V.34/Dual controller application consists of a group of smaller applications, each
devoted to a specific aspect of controlling or monitoring the Dual V.34 modem. There are tw
means of access to the TEAM V.34/Dual applications: the Map window menu bar, and the F
Panel window Select button menus. This chapter describes both. 

The menus group four applications in the Performance category: Alarm Detail, Reports, Cal
Statistics, and Modem State each display information in read-only windows to let you keep tra
modem activities and operating conditions. The Reports application also enables you to sav
delete selected records. This chapter fully describes those four applications. 

There are two applications in the Configuration category: Configure and Maintenance each s
read/write windows by which you can review and alter modem operating parameters. This c
describes how to access the Configure and Maintenance applications. Instructions for using t
applications appear in Chapters 3 and 4. 

The Diagnostics/Dialing application supports a read/write window by which you can comman
test functions of the modem and view test results. The Dialing function is incorporated in the
window to facilitate tests that require connection to a remote modem. This chapter describe
to access the Diagnostics/Dialing application. Instructions for using the application appear in
Chapter 5. 

Three items appear on the Shelf Map menu bar as Misc (miscellaneous): Information, which
displays version and copyright information on the application software; Front Panel Poll Rat
which affects the Front Panel display; and Note Pad. This chapter describes all three. Of thes
items, only Information appears in the Front Panel Select button menu. It can also be access
the Front Panel by clicking the mouse on the GDC logo in that display. 

Map Window Menu Bar Access
The table on the following page illustrates how TEAM V.34/Dual application functions are 
arranged on the menu bar at the top of the Shelf Map window. The table shows menu selecti
both the TEAM Dual V.34 and the TEAM V.34 applications. Map window menus include 
selections in addition to those that apply to the TEAM products because the window also pro
access to other applications. 

You must select the modem you intend to work with before you open the menu you intend t
Select a Dual V.34 modem or a V.F 28.8 modem by clicking the mouse on its icon in the she
058R716-V300 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 1-3
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The Performance menu Front Panel selection opens the Front Panel display window. It is n
included in the Front Panel display Select button menus. Those menus also omit the Front P
Poll Rate and Note Pad selections from the Misc menu. All other selections in the menus that 
above do correspond to selections in the Front Panel window Select button menus. 

Modem Front Panel
The Front Panel display window (See Figures 2-1 and 2-2) provides a graphical interface to a 
selected modem. You can launch a Front Panel in either of two ways:

• select the unit you intend to work with in the shelf map window, then select Front Panel 
the Performance menu for that window

• display the shelf sub-map that includes the unit you intend to work with, then double clic
mouse on the slot icon for the unit. 

The application responds by displaying a window that depicts the modem front panel, with L
that reflect the states of the indicators on the physical unit. Unless otherwise noted in the lis
follow, an LED appears bright green to indicate On or dark green to indicate Off. A two-head
arrow superimposed on a bright green LED indicates transitions. 

Menu Bar - 
TEAM Dual 

V.34
Menu Selections

Menu Bar - 
TEAM V.34

Menu Selections

Performance Front Panel... Performance Front Panel...

Alarms A... Alarm Detail...

Alarms B... Reports...

Reports... Modem State...

Modem State A... Call Statistics...

Modem State B... Configuration Configure...

Call Statistics A... Maintenance...

Call Statistics B... Fault Diagnose... 

Configuration Configure Modem A... Misc Information...

Configure Modem B... Front Panel Poll Rate...

Maintenance A... Note Pad

Maintenance B...

Fault Diagnose A... 

Diagnose B... 

Misc Information...

Front Panel Poll Rate...

Note Pad
1-4 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 058R716-V300
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Introduction to TEAM V.34/Dual Modem Front Panel
The Dual V.34 Front Panel display shows the following indicators: 

ON Power On

SD Send Data, one each for Modem A and Modem B, indicates 
transitions while the modem is receiving data from its DTE to 
transmit. 

RD Receive Data, one each for Modem A and Modem B, indicates 
transitions while the modem is receiving data from the remote 
modem and outputting that data to its DTE. 

OH Off Hook, one each for Modem A and Modem B

CO Carrier On, one each for Modem A and Modem B

TR Terminal Ready, one each for Modem A and Modem B, displays 
On, Off, or transitions 

TM Test Mode, bright red when either modem is in a test mode, 
otherwise dark red

ALM Alarm, dark red while the are no alarm conditions in the dual 
modem; indicates the presence of alarm conditions by changing 
color and displaying A, B, or AB to indicate the modem that is 
currently experiencing the highest priority alarm condition (AB 
indicates both modems have alarms with equal priority). The LED 
indicates by its color the category of the current highest priority 
alarm: orange for major, yellow for minor, green for informational. 

ST Self Test, one each for Modems A and B, bright red while Self Test 
is active on the modem, otherwise dark red 

AL Analog Loopback, one each for Modems A and B, bright red while 
the modem is in the Local Loopback test condition, otherwise dark 
red 
058R716-V300 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 1-5
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The application polls the modem to keep the states of the LEDs in the Front Panel display c

The bottom of a Front Panel display contains a Select button, a status field, and a Help butto
status field displays information on communications between the application and the unit. The
button displays help information concerning the Front Panel display. 

The Select button provides access to menus for the rest of the TEAM V.34/Dual application
functions. The following table shows the arrangement of the Select button menus. It differs 
somewhat from the arrangement on the Map window menu bar. 

The V.F 28.8 Front Panel display shows the following indicators: 

TXD Transmit Data, indicates transitions while the modem is receiving 
data from its DTE to transmit.

RXD Receive Data, indicates transitions while the modem is receiving 
data from the remote modem and outputting that data to its DTE. 

RTS Request To Send

CTS Clear To Send

DCD Data Carrier Detect 

GD Good Data 

DTR Data Terminal Ready

OH Off Hook 

TM Test Mode, bright red when the modem is in a test mode, otherwise 
dark red 

ALM Alarm reflects the OpenView status of the unit, rather than the 
alarm status that is displayed in the Alarm Detail window. Green 
indicates the modem is in normal operating mode; Red indicates a 
critical condition (unit failure); orange indicates a major alarm 
condition; yellow indicates a minor alarm condition; blue indicates 
an informational alarm (warning) condition. The color of this 
indicator matches the color of the shelf submap icon for the unit. 
1-6 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 058R716-V300
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The two Poll selections in the Select button menu determine when the application collects n
information from the modem to update the Front Panel window:

• Selecting Demand Poll causes an immediate update of the display. 

• Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable aut
polling. If you select Disable the Front Panel window displays a static snapshot of the LE
states as they were at the last poll, either when the window was launched or a subseque
Demand Poll. 

The menu selection Exit dismisses the Front Panel window when you click on it. 

TEAM Dual 
V.34 Select 

Button Menu

Second Level 
Selections

Third Level 
Selections

TEAM V.34 
Select Button 

Menu

Second Level 
Selections

Modem A Performance Reports... Performance Alarm Detail...

Alarms... Call Statistics...

Modem State... Modem State...

Call Statistics... Reports...

Configuration Configure... Configuration Configure...

Maintain... Maintenance...

Fault... Fault Diagnose...

Modem B same as Modem A Misc Information...

Misc Information... Demand Poll

Demand Poll Auto Poll 15 seconds

Auto Poll 15 seconds 30 seconds

30 seconds 60 seconds

60 seconds Disable

Disable Exit

Exit
058R716-V300 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 1-7
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Common Window Features
Each TEAM V.34/Dual application you select opens an on-screen window in which to opera
number of features are common to many of the windows: 

Descriptions in this manual of the individual TEAM V.34/Dual applications identify window 
features that are specific to the applications, such as selections in the Menu bar and menus
buttons. 

Triangle button – in the title bar; reduces the window to an icon when you click on it. Double clicking on 
icon restores the window. This button appears on the top level window for each 
application when the application is run on a Sun workstation.

Title bar – identifies the specific TEAM V.34/Dual application running in the window; for example 
TEAM Dual V.34 Main Configuration, TEAM V.34 Main Configuration, TEAM Dual V.34 
Diagnostics, or TEAM V.34 Diagnostics 

Menu bar – always contains the selections File, on the far left, and Help, on the far right. File menu 
always contains the selection Exit, by which you can dismiss the window; some window 
File menus contain selections special to the window. Help menu provide access to 
information concerning the window. Some windows have additional Menu bar selections. 

The Menu bar appears on the top level window for each application. A Menu bar appears 
in the Main Configuration window, for example, but not in the windows you access from 
Main Configuration.

Name field – identifies the unit the application is currently connected to by displaying the user-
configured shelf name, followed by the slot number, the selected modem (A or B) when 
working with TEAM Dual V.34, and the user-configured device name. 
1-8 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 058R716-V300
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Chapter 2: Operation

Performance Functions
This section describes the performance functions which include the Alarm application, Call 
Statistics application, Modem State application, and the Reports application.

Alarm Application

You can launch the Alarm application from the shelf map Performance Menu or from the fro
panel menu. The application displays the read-only Alarms Detail window (shown below) fo
selected modem. The TEAM application gets alarm indications from the modem by receiving
that the SCM sends in response to alarm conditions at the modem, or by polling the SCM fo
changes in alarm conditions at the modem. Alarm states are defined by color: Alarm Not Ac
dark green; Major Alarm – orange; Minor Alarm – yellow; Informational – bright blue.

 Major Alarms

Poor Signal Quality – results from excessive signal-to-noise ratio o
the VF Line 

Modem Cfg Checksum Error – occurs when the checksum 
calculated for the modem configuration does not match the check
value stored earlier 

DCD Loss – occurs when there is no carrier signal being received
the line 

Call Failed – can occur for a variety of reasons; check the Call 
Statistics window or the Reports window for detailed information
when a Call Failed alarm occurs 

DTR Loss – occurs when there is no Data Terminal Ready signa
from the DTE 

Max Call Length Exceeded – occurs when the duration of a call 
exceeds the configured call length threshold 

Retrain Count Exceeded – occurs when the number of retrains 
exceeds the configured retrain count threshold 
058R716-V300 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 2-1
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Minor Alarms

Ring, No Answer – occurs when an incoming call rings but the modem does not answer. 

Fallback – indicates that the modem has gone into fallback operation as the result of degrad
conditions.

No TXD Transitions – occurs when no Transmit Data transitions between polls are detected 
DTE interface; indicates possible error condition at the DTE. 

No RXD Transitions – occurs when no Receive Data transitions between polls are detected 
DTE interface; indicates possible error condition at the remote end. 

On Dial Backup – occurs when a modem that normally operates on a dedicated line connectio
initiated a switched network connection due to problems with the dedicated line (does not a
on the TEAM Dual V.34 Alarm Detail screen).

Remote Cfg Session Active – occurs when the modem is in a remote configuration session, sen
configuration commands to a remote modem.

Test Timed Out – occurs when a diagnostic test is ended automatically by the Test Time lim
configured for the modem in its General configuration. 

Informational Alarm

Power Up – is recorded each time the Dual V.34 modem is turned On or reset 

Alarm Detail Window Menus

The Alarm Detail window menu bar has a File menu and a View menu. 

• File menu contains Exit  selection, used to dismiss the window. 

• View menu provides the Major  selection, Minor  selection, and Informational  
selection. Click on a check to remove the associated alarm category from the disp
window. Click on an empty box to restore that alarm category to the display. 
2-2 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 058R716-V300
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Call Statistics Application

You can launch the Call Statistics application from the shelf map Performance Menu or from
front panel menu. The application displays the read-only Call Statistics window for the selec
modem, as shown below.

The Call Statistics window displays statistics on the current call if the modem is connected t
remote modem when you launch the window. If there is not a current connection, the windo
displays the statistics of the last call that took place. A heading above the statistics display f
identifies the information as either Current or Previous. The Last Update display in the lowe
corner of the window shows when the displayed statistics were collected.  

Note For a historical record of more than one call, use the Reports application, which is also accessed thro
the Performance menu.

Table 2-1 Call Statistics Window 

Selection Descriptions

DCE Tx Rate Displays the speed (bps) the modem transmitter connected to the remote 
modem.

DCE Rx Rate Displays the speed (bps) the modem receiver connected to the remote modem.

Call Duration Displays call duration at the time of the last poll. 
Up to 18 hours, 12 minutes, 15 seconds. 

Retrain Count Displays the count (0 - 127) the modem channel performed a retrain sequence 
during the call.

Fallback Count Displays the count)0 - 127) the modem channel fell back to a lower connection 
speed during the call.

Fall Forward Count Displays the count (0 - 127) the modem channel fell forward to a higher 
connection speed during the call.

RX Signal Level 0 to -48 dBm

Signal-to-Noise Ratio 0 to 40 dB

Answer/Originate Mode Originate for call initiated by the SC 5034 DSE.
Answer for call initiated by the remote modem.
058R716-V300 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 2-3
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Disconnect Reason Options

• Not Applicable - Window displaying current call statistics

• User Time Out - Password not entered within required time limit

• Unknown Normal - An intentional, orderly disconnect

• Loss of Carrier

• Loss of Loop Current 

• Remote Abort - Disconnect without orderly shutdown initiated by remote

• Inactivity Time Out - No transmit or receive data detected for configured DTE Inactivity 
interval

• Protocol Failure

• Handshake Failure - All failed during handshake process

• Password Failure - Handshake password did not verify

• Busy - Busy signal at answering modem

• No Dialtone - Originating modem did not get dialtone 

• Call Establishment - Modem unable to carry out command to initiate call

Call Statistics Window Menus

The Call Statistics window menu bar has a File menu and a View menu. 

• File menu contains Exit  selection, used to dismiss the window. 

• View menu contains the Update  selection. Select Update  frequently to refresh the display 
with the latest information while viewing statistics on a current call.

Compression Efficiency Percentage of data compression performed, thereby increasing transmission 
rate efficiency. Displays 100 when data compression is not in use. 

Throughput Number of bytes per second going to the DTE 

Protocol Negotiated Protocol used to manage the connection, determined by the DSE modem 
channel and the remote modem during handshake 

Fax Modulation Displays the modulation scheme used for FAX operations on the connection.
Data No Active FAX, V.17, V.27, or V.29

Fax Class Displays the class of FAX operations used during the connection (None, Class 1, 
or Class 2).

Disconnect Reason Displays the reason the current call disconnected

ISDN Caller ID This selection is not applicable for the TEAM V.34/Dual application.

Table 2-1 Call Statistics Window  (Continued)
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Modem State Application

You can launch the Modem State application from the shelf map Performance Menu or from
front panel menu. The application displays the read-only Modem State window for the selec
modem. Table 2-2 describes the states of functions performed by the selected modem. 

 

Table 2-2 Modem State Window

 Selection Description

Dial Status Displays dialer (not line) status: disconnect, idle, dial, training, retrain, and data.

Diagnostic Test Displays the diagnostic test in progress. 

Protocol Negotiated Displays the on-line protocol in use by the Dual V.34 modem and the remote modem.

DCE Tx Rate Displays the speed (bps) the modem transmitter is linked to the remote modem. 

DCE Rx Rate Displays the speed (bps) the modem receiver is linked to the remote modem. 

DTE Rate Displays the speed (bps) the modem is exchanging data with its DTE. 

FAX Displays the type of transmission currently taking place (Data or FAX).

RTS Displays the state of the Request To Send signal at the DTE interface (On or Off).

SQM Displays the state of the Signal Quality Monitor (On: good signal, or Off: poor/no 
signal. This determines the retraining or fallback/fall forward action by the modem. 

DSR Displays the state of the Data Set Ready signal at the DTE interface (On or Off).

CTS Displays the state of the Clear To Send signal at the DTE interface (On or Off).

DTR Displays the state of the Data Terminal Ready signal at the DTE interface (On or Off).

DCD Displays the state of the Data carrier Detect signal at the DTE interface (On or Off).

TXC Transitions Indicates a transition occurred in the Transmit Clock signal at the DTE interface 
between the most recent poll and the poll that preceded it. On indicates transitions 
occurring. 

RTS Transitions Indicates a transition occurred in the Request To Send signal at the DTE interface 
between the most recent poll and the poll that preceded it. On indicates transitions 
occurring. 

Note When there is not an active connection:
- the DCE Tx Rate field displays the transmission rate of the last connection
- the DCE Rx Rate field displays the reception rate of the last connection.
- the DTE rate displays Last AT, which signifies the rate to be used at next connection.
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Modem State Window Menus

The Modem State window menu bar has a File menu and a View menu. 

• File menu contains Exit  selection, used to dismiss the window. 

• View menu contains the Update  selection. Select Update  frequently to refresh the display 
with the latest information while viewing statistics on a current call.

Reports Application

You can launch the Reports application from the shelf map Performance Menu or from the f
panel menu. The application displays the read-only Call Statistics Report window, shown be
This window displays the call statistics information described earlier for the Call Statisitics 
application, together with additional information on each call. Reports stores and displays a
historical record of statistics on multiple previous calls, unlike Call Statistics which displays 
statistics for just one call: either the call currently taking place or the call most recently comp

Figure 2-1 Call Statistics Report Window

The Call Statistics Report window displays the following items for each call:

• IP Address – of the SCM card through which the modem communicates with the TE
V.34/Dual application 

• Shelf Name – of the shelf occupied by the Dual V.34 modem

• Slot – number identifying the position of the modem in the shelf; in a statistics repor
a Dual V.34 modem A and B are appended to the Slot number to identify the two 
individual modems 

• Date & Time – at which the call was terminated. 

The Call Statistics Report window appears blank until you access the View menu and specify
subset of reports you wish to view. The application can store the statistics of up to 100,000 
and can display up to 32,000 call statistics at a time. The Stored Report Records field in the b
left corner of the window displays the number of records currently stored and the number of re
in the current display grouping. When the 100,000 record limit is reached the application be
overwriting the earliest records. 

Note Some of the information displayed in the Modem State window is also available from the Front Pane
play. Additional modem state parameters are displayed here which are not easily represented by L
2-6 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 058R716-V300
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Call Statistics Report Window Menus

The file menu provides: 

• Save to File  selection saves call statistics records on the workstation that runs
TEAM V.34/Dual application for the purpose of record keeping or later review. 

• Exit  selection dismisses the window. 

The Edit menu provides:

• Delete All Entries  deletes entries from the Call Statistics Report to keep it 
current and at a manageable size. 

• Delete Displayed Entries  selection operates in conjunction with the Set Filte
selection of the View menu. 

The View menu controls display of information in the report window. Nothing is displayed un
selection is made from this menu. The View menu provides the following selections: 

• Today’s Reports  displays all Call Statistics accumulated since midnight of the 
current day.

• Yesterday’s Reports  displays all Call Statistics accumulated during the previo
day.

• Report Filters  accesses the Report Filters window for specifying selection 
parameters to view a subset of all accumulated Call Statistics records. Refer to the
following paragraphs for Report Filters window options. 

Note Deleted call statistics entries cannot be recovered. Perform a Save to File for records you will need ag
058R716-V300 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 2-7
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Report Filters Window

The Reports Filters window, shown below, allows you to divide accumulated records into 
manageable groupings for display. The options you select here determine the criteria by wh
stored call statistics are grouped and displayed in the Call Statistics Report window. When yo
the All Reports  selection at the top of the window, the rest of the window is grayed out an
filtering is performed. When you click the Selected Types  selection, the filtering options 
described below become available. You can then click the check boxes for each individual o
to set its filtering parameters as needed.

Report Filter Options

Received After Time/Date specifies the earliest day, hour, and 
minute from which reports will be displayed. This is the start limit

Received Before Time/Date specifies the day, hour, and minute 
beyond which reports will not be displayed. This is the end limit.

Duration Longer than Interval  will display only statistics for calls 
that lasted longer than the specified duration. Use the up/down arr
to specify minimum call length in days, hours, minutes, and secon

Duration Shorter than Interval will display only statistics for calls 
that lasted less than the specified duration. Use the up/down arro
next to the appropriate selection fields to specify maximum call 
length in days, hours, minutes, and seconds. 

Call Type will display statistics for Incoming Only or Outgoing 
Only. Click either check box to limit the display to statistics on 
incoming calls or statistics on outgoing calls. 

Shelf will display call statistics records from a specified shelf. Clic
in the field and type in the name of the shelf from which you want
display statistics. 

Slot displays call statistics records from a specified slot in a specif
shelf. Use the associated up/down arrows next to the Slot Numb
field to select the desired slot. 

Modem displays call statistics records for a single modem in a Du
V.34 modem. This is not a valid parameter when working with a V
28.8 modem. Click on the check box beside the option to select 
Modem A or Modem B. The default condition displays call statisti
records for both modems. 

Disconnect Reason displays call statistics records of calls that wer
terminated for a selected reason. Click on the check box and selec
desired disconnect reason. 

Caller ID is not applicable for the TEAM V.34/Dual application.

Report Filters Procedure

You can activate filter options in any combination. Once selections are made, click OK to en
filter options and dismiss the Report Filters window. Otherwise, click Cancel to dismiss the R
Filters window without applying your selections. 

Note The display in the Call Statistics Report window is updated based on the new filter option settings.
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Call Statistics Data Storage

There are three methods of recording Call Statistics information by which save statistics on de
or automatically. Once this information is saved, you can access individual files which can b
copied, exported, and utilized as needed. 

Basic Record Storage

This method provides a 100,000 record storage capacity for the Call Statistics Report applic
and functions like a very large buffer. Once 100,000 records are stored, the application beg
writing over the oldest record each time a new one needs to be created. 

Save to File Storage

This selection in the Call Statistics Report window File menu opens a pop up window in which
can specify the file name and directory path for storing the group of records currently select
display. 

Daily File Storage

This is an automatic recording of each day’s Call Statistics into a file. The data is recorded a
delimited ASCII text, for use in whatever database, spreadsheet, or word processing applicati
choose to employ. You initialize automatic Daily File storage via a configuration text file nam
callstat_log.conf  stored on the workstation that runs the TEAM application. 

The file contains two configurable items: 

GenerateDailyLogFiles = YES/NO  enables or disables the feature, its default 
condition is NO 

DailyLogFileDirectory = /usr/tmp/callstats  specifies the directory in 
which the data is stored; /usr/tmp/callstats  is the 
default, but you can enter the path to any directory 

Within the Log File Directory the application assigns each file it creates a six-digit name in t
format YYMMDD.log. The first two digits are the year the file is created, the next two are the
month, and the final two digits are the day.

Use the following procedure to control the Daily File feature: 

1. Open a shell tool on the workstation that runs the TEAM application and sign on as the 
user. 

2. Launch a text editor and access the configuration file. Its full directory path and name is

/opt/OV/app-defaults/C/teamvf_common/callstat_log.conf

3. Edit the configurable items as needed. Make sure that you do not leave a space after the
in the input. 

4. Save the editing changes and close the callstat_log.conf  file. 

5. Enter the following three commands to put the new configuration into effect

cd /opt/OV/bin 

./ovstop vfast_callstat_collector 

./ovstart vfast_callstat_collector 

6. Exit from the text editor and close the shell tool. 
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Configuration Functions
This section describes the configuration functions which include the Configuration applicatio
Maintenance application, and the Diagnostics/Dial application.

Configuration

You can launch the Configuration application from the shelf map Configuration Menu or from
front panel menu. When you launch the application, it initially displays the read-only Configura
window. The Configuration application is fully described in Chapter 3, Configuration. 

Configuration Window Menus

The file menu provides the following selections:

• Refresh  discards all unsaved changes and restores all options in the displayed 
configuration windows to the values they are assigned by the current operating 
configuration

• Save to Unit  puts the new configuration into use by the modem.

• Load Template  recalls a stored configuration template that can be modified and sa
to the modem or saved to the modem without modifications.

• Save to Template  stores the current configuration on the workstation for future u
as a template. 

• Compare to Template  identifies differences between the configuration displaye
on-screen and a selected template.

• End Remote Config Update  terminates a remote configuration session and pu
any changes made into effect at the remote modem.

• End Remote Config No Update  erminates a remote configuration session an
discards any changes made rather than putting them in effect at the remote modem

• Exit  dismisses the window. 

The Navigate menu provides access to the following read/write windows where modem cha
operation can be configured. 

• General Options

• Terminal Options

• Protocol Options

• Dialer Options

• Telephone Numbers

• Alarms Reported

• Alarm Thresholds

• Network Options

• Password Options

• Remote Configuration
2-10 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 058R716-V300
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Maintenance Application

You can launch the Maintenance application from the shelf map Configuration Menu or from
front panel menu. The application displays one read/write window by which you can control 
aspects of modem operation that fall outside the scope of Configuration. The Maintenance 
application is fully described in Chapter 4, Maintenance. 

Diagnostics/Dial Application

You can launch the Diagnostics/Dial application from the shelf map Fault Menu or from the 
panel menu. The application displays one read/write window by which you can control a vari
test functions on the modem. The dialing function incorporated in the window enables you t
establish the switched network connection that some test procedures require. This manual 
describes the Diagnostics/Dial application in Chapter 5, Diagnostics. 

Miscellaneous Functions
Miscellaneous functions include the Information window, the front panel Poll rate window, an
Note Pad application. 

Information

You can launch the Information window from the shelf map Misc Menu or from the front pan
menu. Information displays one read-only window that displays the name of the application,
software revision level information, and copyright information. 
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Front Panel Poll Rate

You can open the Front Panel Poll Rate window, shown below, from the Shelf Map Misc Me
The setting you select in this window globally sets the initial polling rate for all Front Panel disp
each time they are opened. 

Figure 2-2 Front Panel Poll Rate Window

Poll Rate Procedures

To set the Front Panel Poll Rate, perform the following steps:

1. Click on one of the poll rate options (Slow, Normal, Fast, or Demand Poll Only). 

2. Select Save to File  from the File menu. 

3. Select Exit  to dismiss the window. Your selection will be retained for all subsequent sess
when the Front Panel display is closed.

If you want to change the polling rate for an individual front panel display for the current ses
only, use the Auto Poll selection in the Select button menu. Changes you make with that me
selection are not retained when the display is closed. 

Front Panel Poll Rate Window Menu

The file menu provides: 

• Save to File  selection saves the poll rate on the workstation that runs the TEA
V.34/Dual application. 

• Exit  selection dismisses the window. 

Note Pad

You can launch the Note Pad application from the Shelf Map Misc Menu. The application op
shell tool on the workstation running the TEAM software. You can use the shell tool to run a
editor, mail tool, or any other software that resides on the workstation. The Note Pad applic
provides this access for keeping records on the system. 

Note The precise polling frequency that results from a setting of Slow, Normal, or Fast depends on a num
of factors. Generally, the higher the poll rate, the more communication and processor capacity is dev
to maintaining the display. 
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Chapter 3: Configuration

Overview

The TEAM V.34/Dual Configuration applications enable you to set modem options through 
convenient group of configuration windows. They also support remote configuration by which
can set the options in a GDC V.34 modem that is connected as a remote to the V.F 28.8 mo
Dual V.34 modem that you are controlling.

Starting the Configuration Application

You can start the Configuration application by either of two methods:

• Select a modem symbol on the shelf submap in OpenView, then select Configure (Conf
Modem A or Configure Modem B for a Dual V.34) from the Configuration menu.

• Click on the Select button of the Front Panel display, click on Configuration and select 
Configure from the resulting menu (for a Dual V.34, select Modem A or Modem B after 
clicking on Select).

User Profiles and Templates

You do not change configuration options individually from the TEAM application. Rather, the
application always loads configurations to the selected modem as a complete set, called a P
Each modem has four preset Factory Profiles. 

You can use a Factory Profile as an operating configuration, or as a starting point for creating
four additional User Profiles for each modem. Any change you make to a configuration optio
requires you to specify which User Profile (0, 1, 2, or 3) is to store the resulting configuration
When you save a profile to a modem, it becomes the current operating configuration. 

You can also use the Maintenance application to instruct the modem to use any of the eight p
(four Factory, four User) when it is powered up and as its current operating configuration. If 
want a modem to load a Factory Profile at power up, you need to save the selected Factory
as one of the four User Profiles.

Profiles are stored in the modem itself. You can also store configuration settings as templates
workstation that runs the TEAM application. The filename extension “.tpl” identifies template f
You can store as many templates as you need.

Template Procedures

To load configuration settings from a template into the modem, perform the following steps:

1. Select Load Template from the File menu. The Select Template window opens.

2. Select a template. The application retrieves the configuration settings of the selected tem
058R716-V300 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 3-1
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3. Select Save to Unit  from the File menu and save the configuration as Profile 0, 1, 2, o
The application stores the configuration settings from the template as the designated pr
and makes them the current operating configuration for the modem.

To save configuration settings as a template, perform the following steps:

1. Completing all your modifications to the configuration.

2. Select Save to Template  from the File menu. A Select Template window appears, 
containing a list of existing templates and a field for entering a new template name.

3. Select an existing template to be overwritten with the new configuration, or enter a name
create a new template. A stored template is available to be loaded by the application an
saved as a profile, with or without further modification, to any DSE modem channel.

To compare the current operating configuration settings to settings stored in a template, perfo
following steps:

1. Select Compare to Template  from the File menu. The Select Template window appea

2. Select a template from the list in the window. The application compares the configuratio
displayed on-screen to the settings of the selected template.

3. The application displays the differences between the two configurations, identifying eac
option that is set differently, the window in which it occurs, its on-screen setting, and its 
template setting.

Note Do not type the.tpl extension when entering a filename. The application appends the extension auto
cally. 
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Main Configuration Functions

You can access Configuration application, either from the submap or from the Front Panel di
When accessed, the application reads the current configuration from the modem and displays
Configuration window, shown below. Pull down menus allow you to completely configure th
selected modem. 

Main Configuration Window Read-Only Display

The main Configuration window title bar displays the application name, TEAM Dual V.34 
Configuration or TEAM V.34 Configuration. The read-only content area of the main window 
displays information which identifies the modem and provides a brief operational status, as 
described below. 

Table 3-1 Main Configuration Window Information

Name Displays the user-configured shelf name and the slot number of the Dual V.34 
modem (A or B) selected for configuration.

Slot State Displays Active or Inactive.

Operational Status Displays Up (in service) or Down (out of service)

Product Type Displays highest data rate available to the modem: 
33.6, 28.8, 19.2, or 14.4 kbps 

Serial Number Displays the serial number of the modem.

DTE Interface Displays EIA 232, EIA 530, or V.35 (TEAM V.34 only).

Software Version Displays the revision level of the modem operating code.

Boot Firmware Version Displays the revision level of the modem boot code.

MIB Version Displays the revision level of the MIB file that enables SNMP control.

Country Displays the country for which modem operation is configured. Some countries 
restrict certain configuration functions and values.

Line Type Displays Dial/Private Line, Dial Only, or Dial 2-wire Private Line 

VF Option Card Displays No Card, Domestic, or Identifier for the type of VF interface daughter 
card installed (TEAM V.34 only) 

Sync Compression: Displays Enabled or Disabled.

Point of Sale: Displays Enabled or Disabled.
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Main Configuration Window Menus

In the main Configuration window, the Navigate pull down menu provides the individual 
configuration windows where you make configuration changes. The File menu allows you to
and retrieve configuration settings in a number of ways. The contents of the two menus app
below. Note that the TEAM application uses the SCM and the modem to indicate when a 
configuration problem has caused an SNMP set error.

Menus Selections Description

File Refresh Reads the current configuration from the modem. 
Configuration changes not saved to a template or profile will 
be lost.

Save to Unit Select Profile 0, Profile 1, Profile 2, Profile 3, or Temporary 
Profile

Load Template Displays a list of available templates.

Save to Template Opens a dialog box for data entry.

Compare to Template Opens a dialog box for template selection

End Remote Config Update Instructs the remote modem to operate with the new 
configuration.

End Remote Config No 
Update

With a User Profile - saves the configuration changes 
without updating the remote modem configuration.

With a Temporary Profile - discards all configuration and 
does not affect the remote modem configuration.

Exit Dismisses the Configuration Main menu.

Navigate General Options
Terminal Options
Protocol Options
Dialer Options
Telephone Numbers
Alarms Reported
Alarm Thresholds
Network Options
Private Line Options 
Password Options

Opens associated Configuration Option windows.

Remote Configuration Select: Start Remote Config or Terminate Remote Config
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Configuring a Local Dual V.34 Modem 

You can always make configuration changes to the current configuration or to stored configu
template without disrupting modem operation. The modem continues to operate using its 
unchanged current configuration. 

1. To edit the current configuration of the modem, click on the Navigate button to display a 
menu of the configuration option windows, and select the one in which you intend to ma
changes.

To edit a template, select Load Template from the File menu and select a template from the
resulting list.

2. Click on the input field for an option you wish to change. A window opens to display all t
available parameters for that field. 

3. Click on the new parameter. The option name and the new value will change from black
white type.

4. If you do not want to save the changes, restore the last stored parameters as follows:

• Click Refresh  to discard changes while keeping the window open

• Click Cancel  to discard changes and close the window.

5. In the same manner, continue to access additional configuration option windows and ma
all of the changes as needed. 

6. From the main Configuration window, use the File menu to save the configuration option
changes as follows:

• Click Save to Unit to store the new configuration in one of four User Profiles (0
1, 2, or 3) in the modem. The changed configuration for the modem becomes the c
configuration. 

• Click Save to Template to save the changes in the workstation as a new temp
or as a change to an existing template.

Selecting Option Values

To select from a list of values, click on the entry field for a configuration item. A window ope
containing all the values that are permitted for that configuration item. Hold down the mouse b
until the highlight is on the desired value, then release the button. The newly selected value a
in the entry field for the configuration item.

Note You can close a configuration window without losing changes by clicking the OK button or the push
icon, located in the upper left corner of the window.

You can keep multiple configuration windows open on-screen and move between them by clicking 
mouse on the one in which you intend to operate. The main Configuration window remains on-scre
throughout the configuration process.

Note  A User Profile is only available to the modem to which it has been saved. However, you can always
a template and save it as a profile to any Dual V.34 modem, with or without further modifications.
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Configuring a Remote V.34 Modem

The Configuration application enables you to configure a remote GDC V.34 modem that is 
connected to a managed (local) modem which is set up for either switched line operation or a 
line connection to its remote.

Starting a Remote Configuration Session

1. Access the main Configuration window for the local modem. You can access the window
either from the submap menu or from the Front Panel display.

2. Select Remote Configuration  from the Navigate menu, then select Start Remote 
Config.

• For switched line operation, a selection window appears.
Enter the desired phone number in the field, or select a number from the list of ten p
number cells stored in the modem. Then, click Dial  to establish a Remote Configuration
session. When the remote modem answers, proceed to Step 3.

• For private line connection to the remote, the local modem will briefly break the 
connection and then re-establish the remote modem into a Remote Configuration se
Proceed to Step 3.

3. The application displays a submap that shows icons for the local unit and the connected 
modem. When you are working with a Dual V.34, the map shows two modems in the loc
unit. Click on the remote modem icon to highlight it.

4. Select Configure  from the Administer menu of the submap. The application displays th
main Configuration window for the remote modem.

5. Perform configuration on the remote modem just as you would on a local modem.

6. When all configuration changes for the remote modem have been made, use the remote
window File menu and click Save to Unit to store the new configuration in one of four
User Profiles (0, 1, 2, 3, or Temporary) in the remote modem.

•  If you select User Profile 0, 1, 2 or 3, the new configuration is stored to that profile
non-volatile memory before the remote configuration session is ended. 

• If you select the Temporary Profile, the new configuration changes are stored 
temporarily. The Update options described below determine whether the changes 
to the Temporary profile are saved at the remote modem or discarded.

Note Unlike local modem configuration, the application does not update the remote modem with the new
figuration at this point. 
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7. From the File menu for the remote modem, end the session by selecting End Remote 
Config Update  or End Remote Config No Update . 

• Select End Remote Config Update  to puts the new configuration into effect as th
operating configuration at the remote modem.

• Select End Remote Config No Update  allow the remote modem to continue 
operation with the configuration it had prior to and during the Remote Configuratio
session. 

Terminating the Remote Configuration Session

At the end of a Remote Configuration session, the local modem and the remote modem retur
connection state they were in before the session:

• Private line operation: local and remote modem re-connect in data mode

• Switched line operation: local modem and remote modem disconnect

Note that the remote modem main Configuration window will remain open until you exit from
as follows:

1. In the local modem Main Configuration window, select Remote Configuration from the 
Navigate menu.

2. Select Terminate Remote Config . The submap remains open until you dismiss it, bu
the remote modem icon disappears from it.

Note If you stored configuration changes in a User Profile, the profile remains saved.
If you used a Temporary Profile, the configuration changes are discarded by the No Update  option.
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 General Configuration Options
You can access General Options from the Navigate menu. The General Options window dis
as shown below. From this window, you can control Dual V.34 modem operation criteria for
Connect/Disconnect, Data Flow, Diagnostics and Power Up.     

Table 3-2 General Configuration Options 

Menu Field Option description

Connect/Disconnect 
Criteria

Answer Mode Ring Detect the modem handshakes in answer mode 
when it detects an incoming ring signal 
(Ring Indicator is On). 

Force Answer  the modem handshakes in answer mode 
regardless of whether it is answering or 
originating the connection.

Originate  the modem handshakes in originate mode 
when it detects an incoming ring signal 
(Ring Indicator is On).
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Connect/Disconnect 
Criteria (continued)

Rings Before 
Auto Answer

0 to 255 rings

Long Space 
Disconnect 

Enable

Disable

Make Busy Disable the modem does not present a busy signal 
while on hook

In Analoop [AL] the modem presents a busy signal during 
Analoop tests 

On RTS Loss the modem presents a busy signal when 
there is no RTS from its DTE 

On DTR Loss the modem presents a busy signal when 
there is no DTR from its DTE

[AL] or RTS/DTR 
Loss

the modem presents a busy signal during 
Analoop tests and when there is either no 
DTR or no RTS from its DTE

Hangup on DCD 
Loss, Dly (secs) 

0 to 25.4 seconds 

None  no hangup on DCD loss

DTE Inactivity 
Disconnect 
(mins) 

1 to 255 minutes

Disable no automatic disconnect for DTE inactivity

Data Flow Criteria DCE Rate Limit Options 4800; 7200; 9600; 12000; 14400; 16800; 
19200; 21600; 24000; 26400; 28800; 
31200; or 33600

Auto 
Fallforward/
Fallback

Disable modem does not perform rate negotiation 
during retrain

Enable modem performs rate negotiation during 
retrain 

Poor Signal 
Quality Retrain 

Disable the modem does not perform signal quality 
retrains 

SQ Three the modem can retrain up to 3 times when 
attempting to achieve acceptable signal 
quality

SQ Forever the modem can retrain as many times as 
required to achieve acceptable signal 
quality 

Carrier Detect 
Resp (secs)

0 to 25.4 seconds

None 

Wait for DCD 
(secs)

1 to 60 seconds

Asymmetric 
DCE Rates

Disable modem transmitter and receiver always 
operate at the same speed

Enable modem transmitter and receiver can 
operate at different speeds

Table 3-2 General Configuration Options  (Continued)
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Restrictions

Some options are marked with an asterisk (*) to indicate that their settings may be determined
restricted by the Country Code, which is factory-configured in the modem. Depending on the co
and the option, a country code restriction may specify a fixed value or it may limit the permitted 
of values for an option. The modem does not accept option value changes that violate Countr
restrictions. 

General Configuration Option Definitions

Answer Mode - sets the mode the modem uses for handshaking in a connection that emplo
separate originate and answer mode frequency bands.

Rings Before Auto Answer - selects the number of rings the modem must receive before it 
performs Auto Answer. This field is Country Code dependent; the range of values shown be
may be restricted by local regulations

Long Space Disconnect - determines whether or not the modem supports the long space disco
function. When the function is enabled the modem reacts to a disconnect request from its D
transmitting 4 seconds of continuous space (BREAK) as a signal for the far end modem to 
disconnect. When the function is enabled the modem also accepts incoming long space disc
signals and disconnects if it receives more than 1.5 seconds of continuous space while it is 

Make Busy - switched-network Make Busy function options. The function specifies condition
under which the modem presents a busy signal to the telephone line despite being on hook
field is Country Code dependent; the range of values shown below may be restricted by loc
regulations

Hangup on DCD Loss, Dly (secs) - determines how long a detected loss of carrier must persis
before the modem performs a disconnect. This field is Country Code dependent; the range of
shown below may be restricted by local regulations.

DTE Inactivity Disconnect (mins) – determines how long a period of DTE inactivity must pers
to cause the modem to perform a disconnect.

DCE Rate Limit  – sets the maximum on-line data rate at which the modem can connect to a r
modem for the V.32, V.32 bis, and V.34 modulation schemes.

Diagnostic Criteria DTE Test 
Control

Disabled modem does not perform loop tests in 
response to DTE interface signals

Enabled modem performs loop tests in response to 
DTE interface signals

Remote Digital 
Loopback 

Disable modem ignores inband remote digital 
loopback commands

Enable modem initiates remote digital loopback in 
response to inband commands

Test Time (secs) Cont continuous, tests run until commanded to 
stop 

10 to 2550 seconds

Power Up Profile Powerup 
Configuration 
Profile

User Profile #0

User Profile #1

User Profile #2

User Profile #3

Table 3-2 General Configuration Options  (Continued)
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Auto Fallforward/Fallback  – determines whether the modem performs rate negotiation whe
does a retrain sequence because of poor signal quality. Rate negotiation can result in eithe
increased rate of operation (fallforward) or a decreased rate of operation (fallback). 

Poor Signal Quality Retrain – determines whether the modem performs a retrain sequence 
because of poor signal quality, and how many times the process is repeated.

Carrier Detect Resp (secs) – determines how long the modem must detect carrier before it tu
on DCD to its DTE. This field is Country Code dependent; the range of values shown below
be restricted by local regulations.

Wait for DCD  (secs) – determines the number of seconds the modem waits for carrier detect
it completes dialing. The value displayed here is also used for the dial command modifiers W
for dial tone before dialing) and @ (wait for quiet answer before dialing). It also sets the time
modem waits for ringback when it originates a call. This field is Country Code dependent; the 
of values shown below may be restricted by local regulations. 

Asymmetric DCE Rates – determines whether or not the modem transmitter and receiver ca
connect to the remote modem at different operating speeds while operating in V.34 mode.

DTE Test Control – determines whether or not the DTE can command the modem to perform 
and remote loop tests by asserting signals at the DTE interface (TEAM V.34 only).

Remote Digital Loopback – determines whether or not the modem can be commanded into a
remote digital loopback test by an inband command from the far end modem.

Test Time (secs) – sets time limit for duration of any diagnostic test. The modem automatical
terminates the test when the limit is reached.

Powerup Configuration Profile – selects the User Profile the modem is to use as its operatin
configuration upon power up or reset. When you perform Save to Unit from the Main Configur
window File menu, the setting of this option acts as a command to the modem rather than bec
part of the User Profile you specify for the save operation. Regardless of what profile it is ru
when power is interrupted, the modem uses the last User Profile specified either here or in 
Maintenance window as its powerup profile.
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Terminal Options
The Terminal Options configuration window contains three groups of options grouped unde
headings Data Mode Criteria, EIA Control Criteria, and Control Sequence Criteria. Some op
are marked with an asterisk (*) to indicate that their settings may be determined or restricted
Country Code, which is factory-configured in the modem. Depending on the country and the o
a country code restriction may specify a fixed value or it may limit the permitted range of va
for an option. The modem does not accept option value changes that violate Country Code 
restrictions. 

Table 3-3 Terminal Configuration Options 

Data Mode Criteria Operating Mode Async Data Modem operates in asynchronous mode 
during both command and data modes

Sync Data, Async 
Cmd

Modem operates in asynchronous mode 
when in command mode, and in 
synchronous mode when in data mode

Character Size (bits) Combinations of 
Data bits

(6, 7, or 8), Stop bits (1 or 2), and Parity 
type (none, even parity, space parity, odd 
parity, mark parity, or auto parity)

Overspeed
Correction 

Extended 2.5%

Nominal 1.25%

DTE Data Rate Autobaud

Last AT

300 bps to 128000 
bls

Async rates

32000 sync to 
112000

Sync data rates
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Data Mode Criteria 
(cont)

Call Progress 
Monitor Resp

Autobaud

Last AT

300 bps to 128000 
bps

Call Progress 
Monitor Resp 

Autobaud

Last AT

300 bps to 128000 
bps

Modem-to-DTE 
Flow Control

Disable No flow control

XON/XOFF Bi-
Directional Signal

Enables XON/XOFF signaling between 
the modem and the DTE

CTS Enables the modem to flow control the 
DTE via CTS 

RTS/CTS Operates the same as CTS, and also 
allows the modem to flow control the 
DTE via RTS as a ready to receive signal

XON/XOFF Uni-
Directional

Enables the modem to control the DTE 
with XON/XOFF but ignore those signals 
when they are sent by the DTE

Clock Stopping Enables the modem to perform flow 
control for synchronous data 
compression by stopping and starting 
transmit clock signals

Clock Throttling Enables the modem to perform flow 
control for synchronous data 
compression by varying the rate of 
transmit clock signals

Local Terminal Echo Enable

Disable

Tx Clock Source Internal Modem uses its own internally-generated 
clock

External Modem uses the DTE clock

Receiver Wrap Modem uses receiver-derived timing

EIA Control Criteria DTR Control Force On Modem ignores DTR transitions

Off In Cmd Mode Modem enters command mode upon 
detecting transition

Off Disc Modem disconnects upon detecting 
transition 

Off Disc Recall User Modem disconnects and recalls the 
selected user configuration upon 
detecting transition

RTS/CTS Delay 0 to 255 
milliseconds

DTR Delay 0 to 255 seconds of 
delay

Table 3-3 Terminal Configuration Options  (Continued)
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Terminal Configuration Option Definitions

Operating Mode – Sets the type of data transfer in the data mode.

Character Size (bits)– identifies character length, format, and parity type of DTE asynchrono
data.

Overspeed Correction – sets the tolerance of the modem for overspeed data from its DTE w
operating in V.14 asynchronous data modes.

EIA Control Criteria 
(cont)

DSR Control On Until Disconnect DSR On at all times, goes Off briefly to 
indicate disconnect

Normal Real DSR as specified by ITU-T

Follow DCD DSR On while Data Carrier Detect is On

Force On DSR On at all times 

CTS Control Command on Data 
RTS

CTS On during command mode, CTS 
follows Request To Send in data mode

Command on Data 
Real

CTS On during command mode, CTS 
operates according to ITU-T 
specifications in data mode

Real ITU-T CTS operates according to ITU-T 
specifications at all times

Force On CTS On constantly

DCD Control Force On DCD On constantly

Real DCD operates according to ITU-T 
specifications

Force on Toggle 
Disc

DCD On constantly, but turns Off briefly 
on disconnect as a signal to the front end

On after Link DCD forced On after connection is 
established 

DSR Test Mode On Analoop DSR On during the test

Off Analoop DSR Off during the test

Control Sequence 
Criteria

Line Feed Char 
(ASCII) 

0 to 127

Carriage Return 
Char (ASCII) 

0 to 127

Hang Up Delay 
(secs)

0 to 255 seconds

Character Abort 
Dialing

Enabled

Disabled

Backspace Char 
(ASCII) 

0 to 127

Escape Char 
(ASCII)

0 to 127

Disable

Escape Char Guard 
Time (msec)

0 to 5100 
milliseconds

Auto-Reliable 
Fallback Character 

0 to 127

Table 3-3 Terminal Configuration Options  (Continued)
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DTE Data Rate– selects DTE bit rate. The modem interprets this configuration item in conjunc
with the handshake mode selected for the modem. The Dual V.34 Modem Operation and 
Installation manual contains more detailed information on this topic in its description of the A
command \T.

Call Progress Monitor Resp – selects the rate at which the modem sends Call Progress Mon
responses to the DTE when the DTE Data Rate is configured for Auto speed.

Modem-to-DTE Flow Control– selects the type of data mode flow control the modem employ
its DTE port. 

Local Terminal Echo – when enabled, the modem echoes characters back to the terminal a
are transmitted.

Tx Clock Source – selects the source of the transmit clock for the modem.

DTR Control  – selects how the modem responds to loss of DTR. This field is Country Code
dependent; the range of values shown below may be restricted by local regulations.

RTS/CTS Delay – Selects the delay between RTS and CTS going on.

DTR Delay – Selects the delay (in seconds) between making data mode and raising DTR. It
mode-of-operation dependent. When configured for &M0, this option is used to debounce D
The default is.05 seconds. When configured for &M1 and in the data mode, this option sets th
available to the operator to switch the EIA cable from asynchronous to synchronous equipm
When the timer expires this option is used to debounce DTR. The default is 5 seconds.

DSR Control – selects how the modem controls the Data Set Ready circuit of its DTE interfa

CTS Control – selects how the modem controls the Clear To Send circuit of its DTE interfac

DCD Control – selects how the modem controls the Data Carrier Detect circuit of its DTE 
interface.

DSR Test Mode – selects how the modem controls the Data Set Ready circuit of its DTE inter
during an Analoop test.

Line Feed Char (ASCII) – selects an ASCII character to indicate a Line Feed. This informatio
saved in a template but not in a User Profile. The field returns to a default of 10 when you p
up or reset the modem.

Carriage Return Char (ASCII)  – selects an ASCII character to indicate a carriage return. Th
information is saved in a template but not in a User Profile. The field returns to a default of 13
you power up or reset the modem.

Hang Up Delay (secs) – selects how long the modem waits after detecting a command to han
the line before it performs the disconnect operation. The default is 20.

Character Abort Dialing  – enables character abort feature, in which any character typed at 
DTE within two seconds of the modem going off-hook causes it to abort the dialing process
feature functions only when the modem is configured to accept AT commands and is opera
asynchronous mode.

Backspace Char (ASCII) – selects the ASCII character to indicate a backspace. This informa
is saved in a template but not in a User Profile. The field returns to a default of 8 when you p
up or reset the modem.

Escape Char (ASCII) – selects an ASCII character to indicate the ‘escape to command mod
This information is saved in a template but not in a User Profile. The field returns to a default
when you power up or reset the modem.
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Escape Char Guard Time (msec) – selects the delay the modem uses in determining a valid es
sequence. Upon detection, it transfers from data mode to command mode. This information is
in a template but not in a User Profile. The field returns to a default of 0.50 second when you 
up or reset the modem.

 Auto-Reliable Fallback Character – selects an ASCII character for use as the fallback chara
that can be employed to bypass the negotiation of an error correcting protocol. This informa
saved in a template but not in a User Profile. The field returns to a default of 13 when you p
up or reset the modem.
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Protocol Options
This window permits access to options that are primarily for the set up of Protocol-related is
within the modem, e.g., character handling, data compression, etc. 

Table 3-4 Protocol Configuration Options 

General Protocol 
Options

Asynchronous 
Protocol

Wire The modem runs in wire mode, 
performing speed buffering by copying 
characters from the VF to DTE port and 
vice versa.

Non-speed buffered 
V.14

The modem runs in V.14 asynchronous 
Direct mode. In this mode there is no 
speed buffering and DTE and VF speeds 
must match.

Reliable MNP The modem runs in MNP reliable mode. 
If the modem cannot establish an error 
correcting MNP link it hangs up.

Auto-reliable MNP The modem runs in Autoreliable mode. 
The modem negotiates V.42 or alternate 
links. With no link, the modem enters the 
wire (speed buffering) mode.

Reliable LAPM 
(V.42)

The modem runs in V42 reliable mode. If 
the modem cannot establish an error 
correcting V.42 (LAPM) link it hangs up. 
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General Protocol 
Options (cont)

Asynchronous 
Protocol
 (cont)

Reliable LAPM or 
MNP

The modem runs in reliable LAPM or 
MNP mode. It attempts a V.42 (LAPM) or 
an MNP link; if either fails, it hangs up.

Simulated Control 
Carrier V.13

The modem runs in V.13 mode with 
simulated controlled carrier.

Data Compression Disabled No compression available

Enabled Compression available in both directions

TX path only Compression available only in the 
transmitter path in V.42bis; compression 
available in both directions in MNP 5

RX path only Compression available only in the 
receiver path in V.42bis; compression 
available in both directions in MNP 5

Break Character 
Handling

Expedite Dest Modem immediately transmits a break 
character for 300 msec and erases any 
currently buffered data

Expedite Non-Dest Modem immediately transmits a break 
character for 300 msec, but saves all 
currently buffered data

Non-Expedite Non-
Dest

Modem transmits a break character for 
300 msec in sequence with the rest of 
data.

Ignore Modem ignores break characters it 
receives from its DTE

Timed Non-
Expedite Non-Dest

Modem continues to transmit break 
characters in sequence with the rest of 
data for as long as its DTE transmits the 
character 

Timed Non-
Expedite Non-Dest 
2

Modem continues to transmit break 
characters in sequence with the rest of 
data for as long as its DTE transmits the 
character

Flow Control (Wire 
Mode)

Inhibit Disables flow control between the 
modem and its remote modem

Enabled Enables bidirectional flow control 
between the modem and its remote 
modem based on XON/XOFF signaling. 
Signals are detected, acted on, and 
deleted from the data stream

Unidirectional Provides unidirectional flow control 
between the modem and its remote 
modem. The modem can send XON/
XOFF signals to the remote modem, but 
it ignores and passes to its DTE any flow 
control signals it receives from the far 
end

Bidirectional Acts the same as Enabled except that 
after XON/XOFF signals from the far end 
are acted upon, they are passed to the 
DTE instead of being deleted.

Table 3-4 Protocol Configuration Options  (Continued)
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General Protocol 
Options (cont)

Synchronous 
Protocol

Sync Mode Normal synchronous mode

Sync V.13 V.13 synchronous mode

Enable Sync 
Compression

Synchronous compression mode

Sync Mode Normal synchronous mode

Connect Message 
Type

Separate Messages The modem sends the standard GDC 
connect message upon reaching data 
mode, and sends the V.42 message after 
link negotiation. The connect message 
displays VF line speed.

Both After Link The modem waits until after link 
negotiation to send both the standard 
GDC connect message and the V.42 
message 

Microcom 
Compatible

Same as Both After Link except that the 
modem adds /RELIABLE to the end of 
the message when it establishes a V.42 
error-corrected link

Connect After Link The modem sends only the connect 
message after link negotiation. The 
message indicates the VF rate for V.13 
and V.14 connections. It indicates the 
DTE rate for all other connections

Connect RX & TX 
Asymmetric 

The modem sends a connect message 
specifying separate receive and transmit 
speeds.

Fallback & Prelink 
Data Buffer 

No Buffer The modem discards all data from the 
remote modem until it sends a 
PROTOCOL: NONE message to its DTE, 
the modem then begins passing data to 
its DTE

Buffer RX Data The modem buffers received data (up to 
200 characters) until it has sent the 
PROTOCOL: NONE message, then 
passes the buffered data to the DTE. If 
more than 200 characters are received 
before an error correction link is 
established, the modem falls back to wire 
mode

Fallback with 
Fallback Char

The modem discards all incoming data 
until it detects two consecutive fallback 
characters, at which point it falls back to 
wire mode. the modem passes one 
fallback character to its DTE as data

Fallback V14 Buffer Same as Buffer RX Data except that 
when there is no link the modem falls 
back to V.14 (direct) mode

Fallback V14 with 
Fallback Char

Same as Fallback With Fallback Char 
except that the modem falls back to V.14 
(direct) mode

Table 3-4 Protocol Configuration Options  (Continued)
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Protocol Configuration Options Definitions

Asynchronous Protocol  – Controls protocols available at handshake.

Data Compression – controls how the modem performs data compression while operating in asynchronous 
mode

Break Character Handling  – determines what action the modem takes when it receives a break character 
from its DTE 

Flow Control (Wire Mode)  – controls what type of modem-to-modem flow control the modem uses for non-
error corrected links in wire mode when a constant speed DTE interface is required.

Synchronous Protocol  – selects the type of synchronous data protocol the modem uses

Connect Message Type  – determines when the modem is to send protocol messages to its DTE

General Protocol 
Options (cont)

Retransmit Frame 
Limit

0 to 255

Simulated 
Controlled Carrier 
(V.13 Mode)

Bi-directional Enables V.13 simulated controlled carrier 
on both the T X and the RX sides

TX Enable Enables V.13 simulated controlled carrier 
on the TX side only 

RX Enable Enables V.13 simulated controlled carrier 
on the RX side only

MNP10 Protocol 
Options

MNP10 Mode Disable Modem does not operate in MNP10 
Mode

Answer When negotiating link for an incoming 
call, MNP10 Mode available if requested 
by the remote modem

Answer and 
Originate

MNP10 Mode available for incoming call; 
modem requests MNP10 from the 
remote when originating a call

Cellular Power Level 
Setting 

-10 dBm to -31 dBm

Cellular Power Level 
Adjustment

Disable Unit cannot adjust transmit power level 
during the MNP10 link negotiation; unit 
can adjust power level once link is 
established if requested to do so by the 
remote

Enable Unit cannot adjust transmit power level 
during the MNP10 link negotiation; unit 
adjusts for optimal power level once link 
is established. This selection should not 
be used with 4800 selected as the Link 
Negotiation Speed.

Fixed Unit adjusts transmit power level during 
the MNP10 link negotiation, starting at 
the selected Cellular Power Level 
Setting; power level remains fixed once 
link is established 

Link Negotiation 
Speed

Highest Supported 
Speed

1200 

4800

Table 3-4 Protocol Configuration Options  (Continued)
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Fallback & Prelink Data Buffer  – determines fallback selection and how, when running an error correcting 
protocol, the modem handles data while it waits for establishment of the error correcting link

Retransmit Frame Limit  – selects the maximum number of times the modem can retransmit any one frame 
during an error correcting connection

Simulated Controlled Carrier (V.13 Mode)  – controls operation of the V.13 simulated controlled carrier mode

MNP10 Mode – determines whether or not the unit is to employ the MNP10 protocol. The following three 
options are grayed out when this is set to Disable

Cellular Power Level Setting – selects the initial level the unit is to employ for cellular transmission

Cellular Power Level Adjustment – determines how the unit can adjust power level during cellular 
transmission

Link Negotiation Speed – selects the speed at which the unit operates while negotiating an MNP10 
connection

Dialer Options

This window (Figure 3-5) sets the options for dialer operations performed by the modem.

Table 3-5 Dialer Configuration Options 

Fields and Options Result Code Type Numeric Modem responses are in numeric format.

Alpha Modem responses are in alphabetic 
format.

Call Progress 
Monitor 

Basic Modem blind dials, and sends a 
CONNECT message for all established 
links. All CPM is disabled

Extended No CPM Same as Basic except that the modem 
also sends the connected speed 
following the CONNECT message

Extended Dial Tone Same as Extended No CPM, but without 
blind dialing. Modem sends the NO 
DIALTONE message if dial tone is not 
detected
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Dialer Configuration Option Definitions

Result Code Type –controls the type of responses the modem provides to its DTE when 
commanded to dial. 

Call Progress Monitor – controls Call Progress Monitor operation. This field is Country Code
dependent; the range of values shown below may be restricted by local regulations.

Parser Selection – selects the parser by which the modem recognizes dialing commands fro
DTE. 

DTR Dial – selects what the modem does when it detects an Off-to-On transition on DTR

Response Mode – controls when to send responses.

Fields and Options 
(cont)

Call Progress 
Monitor (cont)

Extended Busy Forces the modem to blind dial. All CPM 
responses are enabled except the NO 
DIALTONE message. 

Extended Full CPM All CPM response codes and monitoring 
enabled except ringback detection 

Extended Full CPM 
Ringback 

All CPM response codes and monitoring 
enabled, including ringback detection

Parser Selection AT

V.25 bis async

V.25 bis HDLC

V.25 bis Bisync

No parser

DTR Dial Disable Modem ignores DTR transitions

Cell Number n Modem dials number stored in cell n (n = 
0 – 9). The application prompts for the 
cell number

 Talk Data Modem starts a handshake on DTR Off-
to-On transition

Continuous Call Cell 
Number n

Modem dials number stored in cell n (n = 
0 – 9) whenever DTR is high and there is 
not an active connection. The application 
prompts for the cell number

Response Mode Enabled Non-quiet mode: result codes are sent to 
the DTE as appropriate

Disabled Quiet mode: no result codes are sent to 
the DTE

Enable In Originate CPM response codes enabled while 
modem operates in originate mode, 
disabled when it detects ring signal and 
enters answer mode

Dialing Type Pulse Pulse Dial

DTMF Dual Tone Multi-Frequency

Dial Pause Time 0 to 255 seconds of 
pause

Wait for Dial Tone 0 to 255 seconds

Table 3-5 Dialer Configuration Options  (Continued)
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Dialing Type – Selects the type of dialing. This field is Country Code dependent; the range o
values shown below may be restricted by local regulations.

Dial Pause Time – Selects the time (in seconds) for pause characters in the dial string. This fi
Country Code dependent; the range of values shown below may be restricted by local regu

Wait for Dial Tone  – Selects the time (in seconds) that the modem waits for dial tone before
disconnecting. This field is Country Code dependent; the range of values shown below may
restricted by local regulations.

Telephone Numbers
The Telephone Numbers window lets you view and modify the contents of the ten telephone
number cells stored in the modem. The window displays all ten cells, each of which can hold
36 characters. 

To modify the contents of a cell:

• Click the mouse anywhere in the input field to create an insertion point and type new inp

 or 

• Click and drag to highlight and replace existing characters in the field. 

Figure 3-1 Telephone Numbers Configuration Window
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Alarms Reported
The Alarms Reported configuration window lets you configure which alarm conditions are to
reported for the modem and which are not. 
   

Table 3-6 Alarms Reported Configuration Options

Report All To highlight all the alarm option selection fields

Report None To remove the highlight from all the alarm option selection fields

DTR Loss Loss of DTR alarm

Fallback Fallback alarm

Receive Data Transitions Receive Data Transitions alarm

Transmit Data Transitions Transmit Data Transitions alarm

DCD Loss Loss of DCD alarm

Ring No Answer Ring No Answer alarm

Retrain Retrain alarm (subject to threshold) 

Call Length Call Length alarm (subject to threshold) 

Call Fail Call Failed alarm

Configuration Error Configuration Checksum error alarm

Signal Quality Poor Signal Quality alarm

On DBU On Dial Backup alarm (TEAM V.34 only)

Remote Configuration Remote Configuration alarm

Test Timeout Test Timeout alarm

Note The Alarms Reported configuration is stored separately from User Profile information and not saved
part of a User Profile. All four User Profiles share the same Alarms Reported configuration.

The Alarms Reported configuration settings in the most recently downloaded configuration determin
alarm mask for all User Profiles.
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Buttons and Option Selection

Each of the alarm options in the Alarms Reported configuration window has a small selection
located to its left. You can select or de-select individual alarm options by simply clicking the m
button on the appropriate selection fields. When an option is selected for its alarm to be rep
its selection field is highlighted. The selection fields next to alarm options that are not to be rep
are not highlighted. 

Alarm Thresholds

The Alarm Thresholds configuration window lets you configure thresholds for the generation
Call Length and Retrain alarms.

Alarm Thresholds Configuration Option Definitions

Call Duration  – determines how long the modem must be continuously on-line before it gene
a Call Length alarm. Two input fields are provided, one for hours and one for minutes. 

Retrains – determines how many times the modem can go through a retraining sequence be
generates a Retrain alarm. 

Network Options

The Network Options configuration window provides access to options that are primarily for
Switched-Network/Private line selections. Note that you can select the Switched-Network Trans
Level option only when the Switched-Network Level Type option is set for Adjustable. 

Figure 3-9 illustrates the Network Options screen for TEAM Dual V.34, which contains three
options that do not appear on the TEAM V.34 version of the screen. In TEAM V.34 those th
options, and others, appear on the Private Line Options screen, which is not present in TEAM
V.34. 

Table 3-7 Alarm Thresholds Configuration Options

Call Duration 0 hours, 1 minute to 18 hours, 12 minutes

Retrains 1 to 25
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Network Configuration Window Definitions

Network Type – Selects the VF line type and mode of operation.

Switched-Network Handshake Mode – available handshake modes. This field is Country Cod
dependent; the range of values shown below may be restricted by local regulations. 

Switched Network Tx Level – shows the output signal level for switched network connection
This field is Country Code dependent; the values shown may be restricted by local regulatio

Switched Network Tx Type – selects the modem for compatibility with the network interface 
which it is connected. This field is fixed to the Permissive setting.

Private Line Tx Level – selects the output signal level for a private line connection. This field
Country Code dependent; the range of values shown may be restricted by local regulations. (
Dual V.34 only). 

Private Line Handshake Mode – available handshake modes. This field is Country Code 
dependent; the range of values shown below may be restricted by local regulations. (TEAM
V.34 only). 

Table 3-8 Network Configuration Window Options

Network Type Switched-Network

Private Line 2 Wire

Switched-Network 
Handshake Mode

V.34 Auto; V.34 Only; V.32 bis Auto; V.32 bis Only; V.32 Auto; V.32 Only; V.22 
bis; V.22 Only; Bell 212; Bell 103; or V.21

Switched Network Tx 
Level 

0 to -15

Switched Network Tx 
Type

Permissive

Private Line Tx Level 0 to -15

Private Line Handshake 
Mode

V.34 Only; V.32 bis Only; or V.32 Only

Private Line Heartbeat Disable

30 to 7650 seconds (assigned in 30-second increments)
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Private Line Heartbeat – selects how frequently the unit is to send a “heartbeat” signal on th
private line when there is no user data being transmitted or received. (TEAM Dual V.34 only

Private Line Options

The Private Line Options configuration window in TEAM V.34 contains options for configurin
network operation when Network Type is selected as Private Line 2 Wire or Private Line 4 W
the Network Options window. TEAM Dual V.34 does not include this screen, but does incorp
three of its options in the Network Options screen. 

Private Line Configuration Option Definitions

Handshake Mode – selects the handshake mode to be used on the private (dedicated) line. 

Tx Level (dBm) – selects the output signal level for the dedicated line connection. 

Down Time (mins) – selects how long the dedicated line must be out of service in order to c
initiation of automatic dial backup (DBU). 

Table 3-9 Private Line Configuration Options

Handshake Mode V.34 Only; V.32 bis Only; or V.32 Only

Tx Level (dBm) 0 to -15

Down Time (mins) 0 to 255 minutes

DBU Lookback Time 
(mins)

Disable

10 to 2550 minutes

Auto Dial Restoral Disable

Enable with End of Session

Enable without End of Session

Private Line Heartbeat Disable

30 to 7650 seconds, assigned in 30-second increments
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DBU Lookback Time (mins) – selects the time interval at which the modem, when operating
DBU, automatically attempts to return to dedicated line operation. The option is set in ten m
increments. When it is set to zero there is no automatic return from DBU to dedicated line ope

Auto Dial Restoral – selects whether or not the modem is to perform automatic dial backup in
event of dedicated line failure. When you enable this option you must make sure that the tele
number to be used for DBU is stored in Telephone Number Cell 0 of the modem. 

Private Line Heartbeat – selects how frequently the unit is to send a “heartbeat” signal on th
private line when there is no user data being transmitted or received. 

Password Options
The Password configuration window permits you to enable or disable password protection f
modem and to specify the password to be used when protection is enabled. 

Password Configuration Option Definitions

Password Operation – Enables or disables the Password option.

Password – input field for specifying the password to be used. Click the mouse on the field a
type the selected password of up to ten alphanumeric characters. The characters you type 
field are not displayed on the screen. 

Table 3-10 Password Configuration Options

Password Operation Enable Handshake Enables password security in which an inband 
password is exchanged between the answering 
modem and the originating modem at the time of 
handshake.

Disabled No password security

Password 1 - 10 characters
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Chapter 4: Maintenance/Diagnostics

Maintenance Overview

The Maintenance application provides functions for controlling the operation of a V.F 28.8 or 
V.34 modem. 

Stating the Maintenance Application

Start the Maintenance application by either of two methods: 

• Select a modem symbol on the shelf submap in OpenView, then select Maintenance 
(Maintenance A or Maintenance B for a Dual V.34) from the Configuration menu

• Click on the Select button of the Front Panel display, click on Configuration and select 
Maintenance from the resulting menu (for a Dual V.34, select Modem A or Modem B aft
clicking on Select)

The window title bar displays the application name, TEAM Dual V.34 Maintenance or TEAM V
Maintenance. The Name field displays the shelf name, the slot number of the unit, for a Dua
the modem (A or B) that is selected, and the symbol label. The main body of the window con
read-only items that display current settings of the maintenance options for the modem. The
pull down menus, File and Edit, allow you to set the maintenance options for the selected m
Note that only one option can be set at a time. 
.

Table 4-1 Maintenance Window Options 

Front Panel Enabled or Inhibited

Busy-Out State Busy or Not Busy

Operational Status  In Service or Out of Service

Powerup Configuration Profile Indicates which of its four User Profiles the modem is to use
058R716-V300 TEAM V.34/Dual for HP OpenView/UNIX, Version 3.0.0 4-1
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Maintenance Window Definitions

Front Panel displays Enabled or Inhibited, indicating whether or not the switches on the front p
of the modem can be used. A selection in the Maintenance window Edit menu controls the F
Panel enable/inhibit function. 

Busy-Out State displays Busy or Not Busy, indicating whether or not the modem has been s
block incoming calls by presenting a busy signal while off-hook. A selection in the Maintena
window Edit menu controls the Busy-Out function.

Operational Status displays In Service or Out of Service.

Powerup Configuration Profile displays which of its four User Profiles the modem is to use as
configuration when it is powered On. A selection in the Maintenance window Edit menu con
Powerup Configuration Profile selection.

Maintenance Window Edit Menu Items
1. Access the Maintenance window, either from the submap menu or from the Front Panel

display. The application reads the current maintenance settings from the selected modem
the window is opened. 

2. To change any of the maintenance settings, click the mouse on Edit in the menu bar. Th
application responds with the following menu of options. Each of the menu items, when 
clicked, displays a selection window to set the options for that item. The settings for eac
menu item are described below. 

Note that the configuration for Alarm Reporting and Alarm Thresholds is not stored as part o
User Profiles, so it is not loaded when you select a profile. Alarm Reporting and Threshold 
configuration is stored separately and is loaded when you download information from the 
Configuration window. 

Front Panel Select Enable or Inhibit to determine whether or not the switches on 
the front panel of the modem can be used. 

Busy-Out State Select Busy or Not Busy to determine whether or not the modem 
presents a busy signal to block incoming calls while off-hook. 

Load Configuration Select, from Factory Profiles 0 – 3 and User Profiles 0 – 3, the profile 
the modem is to use as its current operating configuration. 

Power Up Configuration Profile Select the User Profile (Zero, One, Two, or Three) the modem is to 
use as its operating configuration upon power up or reset. 

Private Line Talk/Data Selects between data mode for normal service and talk mode, in 
which the modem can activate configuration commands. 

In / Out of Service Selects between In Service, which is the normal operating condition, 
and Out of Service. The Out of Service state makes the modem 
appear off-hook to incoming calls, and disables both front panel 
control and AT control from the DTE. The modem is still accessible to 
the TEAM controller, which can command it to place outgoing calls. 

Soft Reset Causes the modem (both modems in a Dual V.34) to perform a reset 
and resume operation using the Power Up User Profile. 
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Diagnostics Overview

The Diagnostics/Dial application enables you to perform a variety of tests on the selected m
Tests can involve just the local unit, or the local unit and the remote modem along with the 
telephone lines that connect them. The dialing function is incorporated in this window so tha
can conveniently make connections for use in testing. 

Diagnostics/Dial Window

The Dial/Diagnostics window is divided into four areas:

• Title bar, menu bar, and Name field.

• Dial/Terminate Call – contains the buttons and field to establish or end connections to re
modems. It also displays Dialer Status and Call Progress Monitor information. 

• Diagnostic Test – contains buttons and check boxes for selecting, starting, and stopping t
functions. It also displays Test Status, Errored Bits (results), and Test Time (duration). 

• Graphic panel – depicts the path followed by test data during the current test. 

Table 4-2 Diagnostics/Dial Window Options 

Menu Bar File Exit

Navigate History

Help Information on the Diagnostics/Dial functions

Dial/Terminate Call Dial Dials the telephone number displayed in the Dial Number field 
The Dial button is grayed out while the modem is connected to 
a remote modem.
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The menu bar contains the selections File, Navigate, and Help. The File menu provides one
selection, Exit. The Navigate menu provides a single selection, History, that gives access to a
of test results in the Diagnostic Log window. This chapter describes the Diagnostic Log follo
the descriptions of tests that can be run from the Diagnostics/Dial window. The Help menu pro
access to. 

Dial/Terminate Call

The dialing and call termination functions permit you to make connection to a remote modem
order to perform Remote Digital Loop (RDL), RDL w/ Self Test, Digital Loop, and end-to-end 
Test procedures. Remember when performing any of these tests that you must make the con
to the remote modem before you initiate the test function. 

The Digital Loop function also requires an active connection. The purpose of Digital Loop, tho
is to direct data from the remote modem back onto the connection for error checking at the fa
Since Digital Loop is used to support testing being performed at the remote modem, the conn
for use with this test is most often initiated from the remote modem. 

Dial/Terminate Procedure

Perform the following steps to connect the selected modem to a remote modem. 

1. Specify the telephone number to be dialed, by either 

clicking on the Phone Number Directory button and selecting from the resulting list of sto
numbers (the number you select appears in the Dial Number field)

or, if the number you need to dial is not stored, click the mouse in the Dial Number entry
and type in the number. 

2. Click on the Dial button.The Dialer Status and Call Progress fields display the progress 
process through dialing and the establishment of the connection. 

3. To end the connection click on the Terminate button. 

Terminate Terminates the current call. The Terminate button is grayed out 
when the modem is not connected to a remote modem.

Phone Number 
Directory

Displays, when you click on it, a list of stored telephone 
numbers that you can select to appear in the Dial Number field. 
The list consists of numbers stored in the modem by means of 
the Telephone Numbers window in the Configuration 
application. The Dial/Diagnostic application reads the list from 
the unit while it initializes the Diagnostics window.

Dial Number Entry field for telephone number selected from the Phone 
Number Directory or typed in. Edits can be made from the 
Phone Number Directory, but the changes will not be stored.

Dialer Status Dynamically updated to indicate the stages of dialing, e.g., Idle, 
Dialing, Training, etc.

Call Progress Indicates the state of the transmission line: idle, on-hook, off-
hook, busy, dial-tone, connected, and (once the link is 
established) the current data rates for DCE transmit and 
receive. This field is dynamically updated.

Table 4-2 Diagnostics/Dial Window Options  (Continued)
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Diagnostic Test
The Diagnostic Test functions select, begin, and end test procedures on the selected modem
procedures test the remote modem and the telephone connection as well as the modem. 

Under the heading Diagnostic Test there are two buttons, Start Test and Stop Test, and six te
which you may select: 

Analoop

Analoop w/ Self Test 

Remote Digital Loop

RDL w/ Self Test

Digital Loop

Self Test

Each test is accompanied by a check box on which you can click to select it as the test to b
performed. 

There are three display fields in the Diagnostic Test portion of the window:

Test Status – indicates the state of the selected test, e.g., Idle, Initializing, test name while
test is running, Terminating.

Errored Bits – indicates the number of bit errors detected during the current (or most rec
diagnostic test. This field is valid for Analoop w/ Self Test, RDL w/ Self Test, and end-to-
Self Test.

Test Time – indicates the duration of the current (or most recent) diagnostic test.

Diagnostic Test Procedure

Perform the following steps to select and carry out a test procedure on the selected modem

1. If the test is to be Remote Digital Loop (with or without Self Test), Digital Loop, or an End
End Self Test, first make sure that the required connection to the remote modem is pres

2. Click on the check box next to the selected test. 

3. Click on the Start Test button. The Test Status field changes from Idle to an indication th
test is initializing. It then displays the test name while the test runs. Also while the test ru
the graphic panel at the bottom of the window illustrates the data path employed by the 

The Errored Bits field is grayed out during any test that does not involve Self Test. Durin
test that does involve Self Test it displays the number of errors detected. The Test Time
updates at regular intervals (not continuously) while the test runs. 

Tests end automatically at the end of the specified period if the Test Time option in the Ge
Options configuration window is set to a numeric value. If that option is set to Continuous,
run until ended by the Stop Test button. The Stop Test button can also stop a test prior 
Test Time limit that would end it automatically. 

Note Remote Digital Loop, RDL w/ Self Test, Digital Loop, and Self Test can only be initiated while the mo
and its remote modem are on a call passing data, and operating in either synchronous mode or dire
(\N1) asynchronous mode. (See the Protocol Options configuration window).
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4. If necessary, click on the Stop Test button to end the test. The Test Status field displays
Terminating and then returns to displaying Idle. The Errored Bits and Test Time fields 
continue to display their values from the most recent past test until another test is perfor

Diagnostics Table
The table below briefly describes the available tests. Each test is described more fully and illu
by a diagram under the headings that follow. 

Analoop
The Analoop test (See Figure 5-2) lets you isolate problems in the operation of the modem and
DTE interface. Specifically, Analoop checks modulator/demodulator operation in the modem,
receive/transmit operation, and DTE interface operation.

Test Description

Analoop Modem initiates a local analog loopback, through which the DTE or 
external test equipment connected to the DTE interface can direct a 
test pattern.

Analoop w/ Self 
Test

Modem initiates a local analog loopback and activates its own test 
pattern generator/checker.

Remote Digital 
Loop

Modem commands the remote modem to initiate a digital loopback. A 
test pattern from the DTE or from external test equipment connected 
to the modem DTE interface can then be directed through the 
resulting test path.

RDL w/ Self Test Modem commands the remote modem into digital loopback and 
activates its own test pattern generator/checker.

Digital Loop Modem loops data it receives from the remote modem back to the 
remote modem.

Self Test Modem activates its test pattern generator/checker.

Note When the modem is configured for \N0, \N2, \N3, \N4, or \N5 mode with a fixed DTE speed, it will n
issue a CONNECT message. When the modem is used in \N1 mode, since the Analoop handshake
may not match the DTE speed selected, it issues a CONNECT _ _ _ _ message at the last known D
rate. If the DTE rate and handshake rate differ, you can change the DTE speed to match the rate rep
by the CONNECT message.
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Figure 4-1 Analoop Test

Analoop with Self Test

Analoop with Self Test employs the same path through the modem as Analoop, but it uses 
pattern generated and checked by the DSE. Because the pattern generator and checker are
to the DSE, the DTE interface is not part of the Analoop test path for this test. 

The self test pattern is composed of alternate ones and zeros for speeds of 1200 and 2400 
all other speeds self test generates a 511 pattern. 

The use of Self Test enables the display of test results in the Diagnostic/Dial window. The E
Bits field displays the number of detected errors. 

Figure 4-2 Analoop with Self Test

Remote Digital Loop

In this test the modem sends a Remote Digital Loop command to the remote modem. In res
the remote modem couples the unscrambled receive-data from its demodulator to its transm
input for transmission back to the modem at the local end (See Figure 5-4).

If the Remote Digital Loopback command is sent to a remote unit that is configured to ignor
incoming Remote Loopback commands, the local modem will drop the line for V.22 bis speeds 
only.

Note This test is not operational when modems are passing data at 300 bps.

Enter test data at the DTE. Compare the data 
that was entered at the DTE with the data that 
is looped back and displayed by the DTE.
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Figure 4-3 Remote Digital Loop

Remote Digital Loop with Self-Test
In this test the local modem sends a Remote Digital Loop command to the remote modem, 
generates a test pattern that it transmits over the telephone line to the remote modem. The 
modem loops the received pattern to its transmitter and sends it back over the telephone lin
modem for analysis (See Figure 5-5). This test checks the modem, the remote modem, and the
telephone line. 

The self test pattern is composed of alternate ones and zeros for speeds of 1200 and 2400 b
test generates a 511 pattern for all other speeds. 

The use of Self Test enables the display of test results in the Diagnostic/Dial window. The E
Bits field displays the number of detected errors. 

Note You cannot perform this test if the remote modem is commanded or configured to ignore a remote d
loopback command.

This test is not operational when modems are passing data at 300 bps.

You can only initiate RDL while the modem is on a call passing data, with wire or direct mode selec
for the async protocol option (See the Protocol Options window).

Note You cannot perform this test if the remote modem is commanded or configured to ignore a remote d
loopback command.

This test is not operational when modems are passing data at 300 bps.

You can only initiate RDL with Self Test while the modem is on a call passing data, with wire or dire
mode selected for the async protocol option (See the Protocol Options window).

Enter test data at the DTE. Compare the data 
that was entered at the DTE with the data that 
is looped back and displayed by the DTE.
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Figure 4-4 Remote Digital Loop with Self Test

Digital Loop

In Digital Loopback (See Figure 5-6) local receive-data is coupled to the transmitter input so th
the remote unit can perform a Loopback test without commanding Remote Loopback. In the
asynchronous mode the clocks are clamped at the EIA interface. The remote modem site is
responsible for test pattern generation and checking in this test. 

.

Figure 4-5 Digital Loop

Self-Test

The Self Test function enables you to perform an end-to-end self test (See Figure 5-7), which is the 
most complete test of the modem, the remote modem, and the connection between them. In 
the modem and the remote modem each generate and transmit a pattern which is then che
errors by the unit receiving it. 

The self test pattern is composed of alternate ones and zeros for speeds of 1200 and 2400 b
test generates a 511 pattern for all other speeds. 

This test requires the cooperation of an operator at the remote modem site to activate the s
function in the remote modem. 

Note You can only initiate Digital Loop while the modem is on a call passing data, with wire or direct mod
selected for the async protocol option (See the Protocol Options window).
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The use of Self Test enables the display of test results in the Diagnostics/Dial window. The E
Bits field displays the number of detected errors received by the modem from the remote m
Results from the pattern the modem transmits to the remote modem are available at the rem
modem site. 

Figure 4-6 End-to-End Self Test

Diagnostics History

You can view a record of tests performed during the current diagnostic session by selecting H
from the Navigate menu in the Diagnostics/Dial window. The record appears as a listing in t
Diagnostics History window (see below). 

Note This test is not operational when the modem and the remote modem are passing data at 300 bps.

You can only initiate Self Test while the modem is on a call passing data, with wire or direct mode 
selected for the async protocol option (See the Protocol Options window).

Table 4-3 Diagnostics History Window Options 

Start Time Date and time test began

Test Name of the test

Test Time Duration of the test in hours:minutes:seconds format
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For a test that does not employ Self Test, such as Analoop or Remote Digital Loop, OK in th
Results column indicates only that the test mode was initiated successfully. Since these test
provide the data path for a test signal without generating or checking the signal, the applicati
no error rate data to display for them. 

To close the Diagnostics History window, click on the pushpin icon in the upper left corner o
window. During an on-going diagnostic session you can close and re-open the Diagnostics H
window without loss of display data. 

The application clears the Diagnostics History when you exit from the Diagnostics/Dial wind

Test Results “OK” for a test that does not involve Self Test or for a test with Self Test in which no 
errors occurred; “Bit Errors:” followed by a bit error number for a test with Self Test in 
which errors were found

Table 4-3 Diagnostics History Window Options  (Continued)
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